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1. Introduction 
1.1.  Intended Use 
The Picarro SI2104 analyzer detects Hydrogen Sulfide in parts per billion. 

This manual describes analyzer operation only. For service tasks, refer to the SI2000 Series 

Service Manual 40-0046. 

Proper use of the SI2000 instruments do not include personnel protection, or monitoring of the 

occupied space. The SI2000 instruments are not safety devices. 

1.2. Personal Protective Equipment 
Any protective equipment shall be used in accordance with the instructions provided by the 

protective equipment supplier. 

1.3. MSDS Required 
Users must obtain the MSDS for sample gasses used in the proxy validation procedure for 

their respective suppliers 

  



Introduction   

6  SI2104 H2S Analyzer User Guide 

1.4. Warning Symbols and Text Conventions 

This manual uses safety icons to emphasize important information in the text: 

• Italic text identifies screen names and to emphasize important text or features. 

• Bold text if for cautions and warning statements and text you should type or select in 

screens. 

Icon notes and warnings provide information on dangers to either yourself or to the analyzer. 

The purpose of these icons is to provide a visual convention to alert you important information. 

 

 

NOTE is an important procedure of which you should be aware of 

before proceeding 

 

WARNING 

LASER WARNING alerts you of a laser danger. 

 
DANGER 

 DANGER indicates an imminently hazardous situation that, if not 

avoided, will result in death or severe injury. 

 
WARNING 

WARNING indicates a potentially hazardous situation which, if not 

avoided, could result in death or severe injury. 

 
CAUTION 

CAUTION indicates a potentially hazardous situation which, if not 

avoided, could result in moderate or minor injury. 

 

REMINDER is a helpful prompt to remember procedures listed in the 

text. 
 

 

  

 CAUTION alerts you of a potential danger to equipment or to 
the user. 

WARNING indicates an imminent danger to the user. 
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1.5. Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an 
embedded 3B laser in accordance with EN 60825-1:2014. 

 
WARNING 

The laser is a Class 3B when exposed.  
Only trained service personnel are authorized to open the housing or 
service the laser in an approved laser safe service area using 
appropriate laser safety glasses. 

 

     

1.6. General Safety 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result in 
damage to the analyzer, and render it unsafe to operate. 

 
WARNING 

Only authorized persons may open the analyzer cover or perform 
internal maintenance. Contact Picarro for maintenance instructions 
and maintenance kits. Unplug the analyzer before working with the 
internal components. Failure to do so may result in electric shock and 
can damage the analyzer. 

 
WARNING 

This analyzer weighs 48 lbs. Lifting it is a two-person job. Use the 
technique described below when lifting the analyzer. 

 

WARNING 

HOT SURFACE: The heating block and metal tubes connected to the 
filter are HOT (up to 100oC). Let the heating block cool before 
attempting to change the filter 
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2. Unpack the Analyzer 
2.1. Inspect the Shipping Boxes 
Picarro products are inspected and tested before leaving the factory. The shipping container 

system has been specially tested and proven to be safe for most dropping, crushing or spiking 

events. 

Picarro shipping containers consist of: 

• An inner box equipped with a shock detector (Figure 1) 

• An outer box 

Figure 1 shows acceptable outer box condition /inner box shock indicator condition. 

 

Figure 1: Shipping Boxes 

 

If the equipment arrives damaged, photograph the damages and contact Picarro (email 

pictures if possible) for consultation on best course of action. 
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2.2. Unpack the Shipping Boxes 

The section describes the contents of the shipping boxes: 

Figure 2 shows the box contents and the Table 1 and Table 2 list the box contents. 

 

Figure 2: Box Contents 
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Table 1: Box 1 Contents 

QTY Item Description 

1 Analyzer 
Module 

Includes all data acquisition, control, and communications 

hardware and firmware to perform all gas handling, 

spectral collection and analysis. 

1 Slides 1 pair of slides and hardware for 19” rack mounting. 

2 A/C Power 
Cables 
NOT 
SHOWN 

2 power cables with connectors appropriate to your 

country are provided. The pump and analyzer 

automatically adjust to local voltage. 

1 Accessories 1 Certificate of calibration 

1 Hardcopy User Manual (this document) 

 

  

  

Table 2: Box 2 Contents 

 1 Pump 
Module 

Provides vacuum required for sample gas sequencing into and 
out of the analyzer. 

  

• Inspect each item to assure it is not damaged. 

• If items are missing, contact Picarro for a replacement. 

• Keep the shipping packages to reuse when transporting the analyzer. 

• Contact Picarro for options on transporting systems to remote labs. 
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3. Analyzer Overview 
3.1. Front and Back Panel Description 
Figure 3 shows the analyzer front panel and Figure 4 shows the analyzer back panel. 

  

Figure 3: Analyzer Front Panel 

 
Figure 4: Analyzer Back Panel 

 
CAUTION 

Do not connect USB hubs or unauthorized USB devices (except flash drives, mice 
and keyboards) to the USB ports (Figures 3 and 4). Unauthorized USB devices 
may interfere with the analyzers functioning. 

 
NOTE 

The analyzer has a universal power supply that automatically adjusts to power sources 
ranging from 100-240 VAC, 50/60 Hz, 250 W max. 
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3.2. Front Panel Operating Status Indicator 

The LED indicator on the front panel (Figures 3 and 5) shows the current operating state of 

the analyzer. Figure 5 shows and describes the status indicator states. The status states and 

colors are linked to the System Alarm Panel on the CRDS Data Viewer Screen. See Figure 9. 

 

Figure 5: Status Indicator States 

3.3. External Vacuum Pump 
Figure 6 shows an example of an external vacuum pump. 

 

Figure 6: Vacuum Pump 
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3.4. Specifications 
• Weight: 48lbs. The analyzer must be lifted by two people. 

• Dimensions 

• Length: 24.38” 

• Width: 7.5” 

• Width with rails:17.75” 

• Height: 7.88 

• Height with feet: 8.38” 

• Temperature range 

• Storage: 0oC-70oC 

• Operation: 0oC-35oC 

• Ambient humidity range: <99% R.H. non-condensing 

• Maximum altitude: 10,000 ft (operation) 

• Front and rear clearance: 6” for ease of connection 

• Power requirements: 100-240 VAC, 50/60 Hz, 250 W max 

• Power supply voltage fluctuation: + 10% of nominal voltage 

• Liquid ingress protection: None 

 
Warning 

This analyzer is designed to be used in an indoor environment. 
Do not operate or store the unit outside or exposed to the 
elements. 

 
Warning 

If the equipment is used in a manner not specified by Picarro, 
the protection provided by the equipment may be impaired. 
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4. Hardware Setup 
Electrical Safety Task Type 2 

Items/Tools Required: 

• 9/16’’ open end wrench 

• 11/16’’ open end wrench 

• Pump 

• Power Cord 

 
Caution 

If you rack-mount the analyzer, be sure to support it with a 

shelf or additional rails, the analyzer cannot support itself 

on the front rackmounts alone. 

 
Caution 

The host solution in which the instrument and pump are 

being installed inside of must have sample gas and CDA 

purge isolation valves provided by the host to system. 

 
Caution 

The host solution in which the instrument and pump are 

being installed inside of must have main overcurrent 

protection devices and main disconnect devices rated for at 

least 10,000 RMS symmetrical amperes interrupting capacity 

(AIC). 

 
Caution 

The host solution in which the instrument and pump are 

being installed inside of must have an EMO. Activation of 

the host system EMO must shut off power and CDA to the 

instrument and pump. The location of the EMO button must 

be within 3 meters of the instrument. 

 
Caution 

The host solution or facility in which the instrument and 

pump are being installed inside of must have lockable 

shutoff valves for the sample and CDA lines. 

 
Caution 

The host solution in which the instrument and pump are 

being installed inside of must have adequate overcurrent 

protection for the power supply to the instrument, pump, 

and voltage supply (maximum of 7A). 

 
Caution 

The instrument is intended to measure concentrations H2S 

up to 0.5 ppm. Operating at concentrations above the 

intended ranges may render the instrument unsafe to 

operate, maintain, service or dispose. 
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Caution 

Sample or CDA lines connected to the ¼” Swagelok 

connectors must not exceed 3 psig. 

 
Caution 

Any light emitted from the Status Indicator, regardless of 

color or state, (Figure 5) indicates one or more lasers are on 

 
Note 

Analyzer performance may degrade (increased 
measurement intervals, or increased measurement noise) 
while exposed to RF Radiation in an Industrial 
Environment between the frequencies of 80MHz - 1GHz at 
a field strength of 10V/m per IEC 61326-1-2013. Make sure 
normal operation conforms to the datasheet for the 
analyzer during the initial start-up sequence after the 
installation procedure is completed. 

1. Remove the analyzer and the external vacuum pump from the shipping containers. 

2. Install the analyzer in a rack, or place it on a cart or table. 

 
 WARNING! 

This analyzer weighs 48lbs. Lifting it is a two-person job. 

Use the technique described below when lifting the analyzer. 

Use this technique to lift heavy objects: 

a. Before lifting, inspect the unit for slippery substances or sharp edges. 

b. Lift with two people, one on each side of the analyzer. 

c. Crouch down and stay close to the unit. Always keep your back as straight as 

possible.  

d. Position your feet for sturdy balance. Lift with your legs, not your back.  

e. Do not twist the back while carrying the unit. Rotate direction with hip joints.  

f. Lower the unit by bending at the knees. 
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Figure 7 shows the warning label positions on the top and back of the analyzer. 

 

Figure 7: Warning Label Positions  

3. Place the external vacuum pump near the analyzer in a rack, or on a cart or table. 

 
Caution 

If you rack-mount the analyzer, be sure to support it with a shelf or 

the provided rails, the analyzer cannot support itself on the front 

rackmounts alone. 

4. Unpack the analyzer accessories. (vacuum line, AC power cables, manual, certificate of 

compliance and certificate of calibration). 

5. Remove the caps from the analyzer gas connection inlet and vacuum connection ports. 

Save the caps from the analyzer and pump. Reinstall the caps when the analyzer is 

stored, moved or shipped. 

 
Note 

 
Store the certificates in a safe place. They may be required if you 
call us for service or questions. 

 

6. Remove the caps from external vacuum pump. Save the caps for later use. Reinstall the 

caps when the pump is stored, moved or shipped.  

7. Connect the vacuum hose between the external vacuum port and the external vacuum 

pump. See Figure 8. Hand tighten the nut, then make an additional 1/4  turn with an 11/16” 

wrench (not supplied). 

8. Connect the AC power cable to the analyzer and to the external vacuum pump. 

9. Refer to Picarro’s SI2000 Series Service Manual 40-0046 for service instructions. 
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Caution 

Use the AC power cables supplied with the analyzer or a similarly rated 

cable. Check with Picarro technical support if you have questions about 

power cable replacement. 

 
Caution 

When working with hazardous gases, attach a tube to the external 

vacuum pump exhaust port and direct the exhaust to a safe place for 

venting the mixture of sample gases. 

 

 

Figure 8: Analyzer and Pump Connections 

 

 
Note 

The analyzer has a universal power supply that automatically adjusts to power 

sources ranging from 100-240 VAC, 50/60 Hz, 10 W max. 

Refer to Manual Number 999085 included in the box for the Vacuubrand MD1 

External Pump Safety, Operation, Specification, and Service Instructions. 
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5. Operate the Analyzer Using the GUI 
This section describes the GUI and explains how to operate the analyzer using the GUI. 

1. Switch on the external vacuum pump. 

2. Switch on the main power to the analyzer (Figure 4). 

 
CAUTION 

Always turn on the external pump before turning on the analyser. 

This ensures a rapid start-up sequence. 

The software starts automatically and the analyzer displays the opening screen. Figure 9. 

Use the buttons on the opening screen to select the activity you want. These buttons are 

password protected to prevent accidental shutdown or configuration changes. From the 

opening screen select: 

• H2S to begin normal operation 

• Files to copy data to an external device 

• Config to perform configuration tasks (password is picarro) 

• Service to perform service tasks (for trained personnel only) 

• Power Off for a soft shutdown (password is picarro) 

 

Figure 9: Opening Screen 
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5.1. The CRDS Data Viewer (Main Screen) 

Single click on the H2S button and wait about 30 seconds while the acquisition software 

initializes.  When initialization is complete the CRDS Data Viewer screen displays. 

This section describes the CRDS data viewer. This is the analyzer main screen. The data 

viewer shows a graph for H2S 

Analyzer initialization is complete when the CRDS Data Viewer screen displays and sampling 

begins. Figure 10 shows the CRDS data viewer for Hydrogen Sulfide. 

 

Figure 10: CRDS Data Viewer Screen 

Data is saved automatically whenever the analyzer produces data. The data displayed on the 

CRDS is the continuous real time read-out from the analyzer. 

A user-relevant subset of this data is stored in 

/home/picarro/SI2000/UserData/DataLog_User/YYYY/MM/DD, where: 

• YYYY = year  

• MM = month 

• DD = day 

For example: June 28, 2017 is written 2017/06/28 

Further details can be found in the file management section. 
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5.2. CRDS Data Viewer Field Descriptions 

Users Menu 
Left clicking on the Users menu shows the drop-down User Login. Depending on your level of 

access, different menu items will be enabled. 

Figure 11 shows the Users drop-down Menu. 

 

Figure 11: Users Drop-Down Menu 

View Menu 

This menu item has three choices (Figure 12): 

1. Lock/Unlock time access when zoomed: This is a toggle. When locked, the data windows 

display the same time scale during zoom. 

2. Show/hide statistics: Toggles the measurement statistics display. 

3. Show/hide instrument status: Toggles the instruments status display. 

Figure 12 shows the View drop-down menu. 

 

 

Figure 12: View Drop-Down Menu 
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Tools Menu 

Use the tools drop-down menu to Show/Hide Valve Sequencer GUI. This option toggles the 

display of the external valve sequencer window. 

Figure 13 shows the Tools drop-down menu. 

 

Figure 13: Tools Drop-Down Menu 

Help Menu 
Click About to display the version number of the analyzer. 

Alarm Panel 
Click on an item in the alarms panel to view the Setting Alarm dialog for that item. This panel 

is used to monitor the status of the internal analyzer alarms. 

System Alarm monitors the current analyzer status, such as pressure, temperature, and 

measurement. 

H2S Alarm monitors the gas pressure 

Figure 14 shows the Alarms panel. 

 

Figure 14: Alarm Panel 

The H2S alarm is a gas concentration alarm indicator. The gas concentration alarm indicators 

(Figure 14) is: 

• Green when the concentrations are within set limits 

• Red when the concentrations are above or below the limit values 

The System Alarm indicators are: 

• Green when the analyzer is functioning normally 

• Yellow when the analyzer has an operational issue (for example, if cavity pressure is 

outside normal limits) 

• Red when the analyzer is not measuring 
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To view the alarm set points for a gas, click on the indicator next to that gas (Figure 14). The 

Alarm Set dialog displays (Figure 15). You can read or change the alarm settings and allow the 

user to enable it or change the set point. In Figure 15, the indicator illuminates when the 

concentration goes above 50 and resets (indicator off) below 45. 

The alarm modes for gasses are: 

• Higher 

• Lower 

• Inside 

• Outside 

 

Figure 15: Alarm Set Dialog 

To set the alarm, type the desired threshold values and click OK. 

If you don’t need to change the alarm value, click Cancel. The dialog box will disappear and 

the alarm value will remain unchanged.  
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Digital Readouts 

The digital readouts show the latest value recorded for the selected data key for each data 

window. The changes in the data key are reflected in the digital readout in the data window 

view. If the Show Statistics entry is enabled in the View menu (Figure 12), the mean, standard 

deviation and slope of the data in the graph is dynamically calculated and indicated below the 

digital concentration readout. These numbers change to reflect statistics of whatever data is in 

the data window. 

Figure 16 shows the digital readout panel. 

 

Figure 16: Digital Readout Panel 

Restart User Log 

The analyzer automatically records all data collected and saves it for later analysis. These 

files are called DAT files after their extension (.dat) see Appendix A - File Management. Click 

Restart User Log(s) to start recording a new data file. Figure 17. 

 

Figure 17: Restart User Log(s)Button 

 

Data Log Filename and Path 

The filename and path of the active data log is displayed in this panel. 

Figure 18 shows the data log and filename and path panel. 

 

Figure 18: Data Log Filename Panel 
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Data Window 

The data window displays a graph of streamed data verses system time, with a format of 

hh:mm:ss. 

• Select which data stream is displayed using combinations from the Data Source and 

Data Key drop-down menus.  

• Adjust the number of significant figures displayed using the Precision menu. 

• Adjust the auto-scaling of the Y axis using the Auto-Scale drop-down. 

Figure 19 shows the data window. 

 

Figure 19: Data Window 
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Instrument Status 

Enable the Show Instrument Status using the View menu on the main toolbar digital readouts 

for these parameters are displayed to the left of the data windows. 

• Warm box temperature in 0C 

• Cavity temperature in 0C 

• Cavity pressure in torr 

Figure 20 shows the Instrument Status. 

 

Figure 20: Instrument Status 

Data Source Drop-Down Menus 

Use these menus to select the data stream that is viewed in the data plot. Left click on the 

arrow next to a source to view the available data streams: 

• Instrument Analysis shows gas concentrations. 

• Sensors displays data from the analyzer’s sensors. 

Figure 21 shows the Source Key drop-down menus. 

 

Figure 21: Source Key Drop-Down Menu 
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Data Key Drop-Down Menus 

Figure 22 shows the data key drop-down. When you select an option the analyzer generates a 

data plot for that option. 

 

Figure 22: Data Key Drop-Down Menu 

 

Precision Drop-Down Menu 

Click on these drop-down menus to select the precision displayed on the y-axis of the data 

plot, between 0 and 4 digits of precision or auto. This affects only the data plot displayed in 

the data window, not the data stored in any files. Figure 23 shows the Precision drop-down. 

 

Figure 23: Precision Drop-Down Menu 
 

Status Log Window 

Click here to display analyzer status messages, in this format: MM/DD/YYYY hh:mm:ss 

generic message text. These messages include all messages sent to the DAS. 

Reset Data Buffer Button 

Click here to clear the internal data buffer of the GUI (this clears the current data traces from 

the graphs). This has the effect of clearing all data in the data window. Clicking this button has 

no effect on any of the data log files stored by the analyzer. See Figure 24. 
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Data Buffer Level Meter 

The green bar to the right of the Data Window shows the amount of GUI buffer memory used 

to retain historical data collected by the analyzer. When the maximum number of data points 

is collected and the buffer is full, old data is removed from the buffer as new data is collected. 

This affects only the data displayed in the data window, not the data stored in any files. 

This buffer automatically resets when the analyzer starts, and can be emptied at any time by 

clicking the Reset buffers button in the lower-right-hand corner of the GUI. Figure 24 shows 

the Data Buffer Level Meter and Reset buffers button 

 

Figure 24: Data Buffer Level Meter and Reset Buffer Button 
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Zoom in on the Data Window 

Zoom in on a section of the data window to get a detailed view of the graph. To zoom an area 

of the data window:  

1. Move the cursor over the graph you want to magnify. 

The cursor changes from an arrow to a magnifying glass. 

2. Drag the magnifying glass over the section you want to zoom while holding down the left 

button. 

A box appears to show the zoom area. 

3. Release the left button and boxed area will automatically scale to fill the data window. 

• To auto-scale the y-axis of either graph, use the auto-scale buttons below the graph. 

• To lock or unlock the time axes of each graph during zooming, select that menu item in 

the View menu. 

Figure 25 shows the auto-scale buttons. 

 

Figure 25: Auto-Scale Buttons 
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5.3. File Transfer 

Click on Files to copy data to an external device.  

The File Transfer screen displays. Figure 26 shows the File Transfer screen. 

To transfer a file: 

1.  Highlight the file in the left panel. 

2. Left-click on the file. 

3. Drag the highlighted file to the right panel. 

4. Release the left mouse button 

The files transfer to the selected device. 

f 

Figure 26: Transfer Files  
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5.4. Configuration Menu 

To access the configuration menu: 

1. Click on the Config button to configure the analyzer. See Figure 9. 

The Config Password dialog displays. See Figure 27. 

 

Figure 27: The Config Password Dialog  

2. Enter the Config Password: picarro. 

3. Click OK. 

4. The Configuration Menu displays. See Figure 28. 

 

 

Figure 28: The Config Screen  
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Network 

Click on Network to view the current IP address of the analyzer. Figure 29. 

 

Figure 29: The Network Dialog 

Clock 

Click on Clock (Figure 28). 

The Set Time and Time Zone dialog displays (Figure 30). 

Use this dialog to: 

• Set the clock for a new time zone. 

• Manually set the correct time. 

 

Figure 30: The Clock Set Dialog 
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Set the Local Time Zone 

1. Click on the Local Timezone drop-down and select the location you want. Figure 31. 

The Local Date/Time field changes to the date and time for the location you selected. 

2. Click Set to save the changes and return to the config menu. 

 

Figure 31: The Clock Set Menu  

Manually Set the Time 

Use the Set Time Manually check box (Figure 32) to manually reset the clock to the correct 

date and time when the clock is set to the wrong time. 

1. Check the Set Time Manually check box. 

2. Click Set to save the changes and return to the config menu. 

 

Figure 32: The Clock Set Dialog  
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Serial Port 

Click on Serial Port on the Config screen (Figure 28) to access the Serial Port Dialog. The 

serial port dialog lets you change the baud rate. Figure 33 shows the serial port dialog. 

 

Figure 33: The Serial Port Dialog  

To Change the baudrate: 

1. Click on the Baudrate dialog. Figure 33. 

2. Select the baudrate from the menu options. Figure 34. 

3. Click Save. 

4. Click OK. 

 

Figure 34: Baudrate Options 
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User Management 

1. Click on Users (Figure 28) to access add users or change user permissions. 

The user login dialog displays. Figure 35. 

2. Enter the user name (admin) and password (admin) and click the Login button. 

 

Figure 35: Users Login 

3. The User Accounts dialog displays. Figure 36. This dialog lists user accounts and roles 

authorized for the analyzer. From the user accounts dialog 

4.  you can: 

• Change Passwords 

• Change Role 

• Disable Users 

• Add Users 

 
NOTE 

 
Tech, operator and admin are the default users and rolls that are 
shipped with the analyzer. 

 

 

Figure 36: User Accounts Dialog 
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To change a password: 

1. Click to highlight the user whose password you want to change. Figure 36. 

2. Click Change Password.  

3. Click on the user password you want to change. 

The Change Password dialog displays. Figure 37. 

4. Enter the new password. 

5. Confirm the new password. 

6. Click Next to save the password. 

 

 

Figure 37: Change Password Dialog 

 

To change a user’s role: 

1. Click to highlight the user role you want to change. Figure 38. 

2. Click Change Role.  

The Change Role drop-down menu displays. Figure 38. 

 

 

Figure 38: Change Role Drop-down 
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3. Select the role for the user. 

The Confirm Action dialog displays. Figure 39. 

4. Click OK to confirm the changed role. 

 

Figure 39: Change Role Confirmation 

To Disable a user: 

1. Click Disable User. Figure 40. 

The Confirm Action dialog displays. 

2. Click OK to confirm the action. 

 

Figure 40: Disable Confirmation 
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To add a user: 

1. Click Add User. Figure 41. 

The Add User dialog displays. 

2. Fill in the fields in the Add User dialog. 

3. Click next to go to the next step. 

 

Figure 41: Add Users Dialog 

The New User Account Verification dialog displays. Figure 42. 

 

4. Review the user information and click OK to accept or Cancel to reject the new account. 

 

 

Figure 42: Add Users Account Verification 
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5.5. Shutdown Procedure  
To shut down the analyzer: 

 
NOTE 

 
You must be logged in to shut down the analyzer. 

 

1. Log in as admin: 

a. On the Menu Bar click on Users and choose User Login. Figure 43. 

 

Figure 43: User Login Tab 

 

b. Enter the password an username (both are admin) and click OK. Figure 44. 

 

Figure 44: User Login Dialog 

2. Click Quit on the data viewer screen (Figure 10). 

The analyzer displays the Analyzer Shut Down dialog. Figure 45. 

 

Figure 45: Analyzer Shutdown Dialog 
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3. Click Yes. 

The analyzer shuts down: 

a. Cavity fills with clean gas from the inlet until it reaches near atmospheric pressure. 

b. Status log shows the pressure as the cavity is filled. 

c. Proportional valves close. 

d. Software shuts down. 

e. Analyzer powers off. 

5.6. Recovery from Power Outage 
When the power returns after an unplanned outage, the analyzer restarts automatically. The 

Picarro software: 

• Closes files that were interrupted by the power outage. 

• Opens new files for data collection. 

• Data, analyzer diagnostics and other parameters recorded up to the time of power 

outage are retained. 

If short power outages will be a routine operating environment, Picarro recommends using 

power conditioning or an uninterrupted power supply to help prevent damaging operating 

system and software corruption problems that can occur with repeated crashes. 
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6. Troubleshooting 
This section lists problems that may occur during installation and operation of the analyzer, 

and step-by-step procedures that will provide resolution in most cases. If these instructions do 

not solve the problem, contact Picarro Technical Support. 

Status State Indicator on the Analyzer Front Panel is Not On 

Pressing the main power switch does not start the analyzer and the status indicator on the 

front panel is not on when the analyzer is on. 

The indicator on the front panel (Figures 3 and 46) shows the current operating state of the 

analyzer. Figure 46 shows and describes the operating status indicator states. 

 

Figure 46: Status Indicator States 
 

1. Check that the AC power cord is attached and plugged into a working outlet. 

2. Check that the rear ON-OFF switch near the AC power cord is in the ON position. 

3. Press and hold the rear panel power switch for at least 5 seconds as the analyzer may 

take several seconds to respond. 

 

 
CAUTION 

 
Do not restart windows without cycling the power to the analyzer. 
Restarting windows will not fix this problem. 
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Cavity Pressure Cannot be Adjusted for Concentration Measurements 
The cavity pressure is automatically locked to the correct value during normal operation. 

The Pressure Locked message on the lower left corner of the GUI indicates that the cavity 

pressure is within operating parameters. See Figure 47. 

  

Figure 47: Status Log for New Filter  

If the cavity pressure is out of operating specification the GUI displays a Pressure high or 

Pressure Low message. 

1. The Pressure Low message on the GUI indicates that there is insufficient gas available at 

the analyzer gas inlet.  

• Check the inlet plumbing to the analyzer. 

• Ensure that the pressure/flow at the inlet is within specifications. 

2. The Pressure High message on the GUI indicates that gas cannot exhaust from the 

analyzer at a sufficient rate.  

• Check the vacuum line between the analyzer and the power vacuum unit for leaks. 

• Check the vacuum pump. Make sure it is functioning correctly. 

• Check the gas pressure inlet for excessive pressure. 

User Interface Program Does Not Update Graphs as Data is Collected 

The computer may become unresponsive causing the programs that control the analyzer to 

stop functioning. If this happens: 

Shut Down the Computer 

If the computer responds to the mouse, follow the shutdown procedure on page 40: 

1. Wait until the computer is completely shut down. 

2. After a few seconds, start the computer using the power button. 

If the computer does not respond to the mouse: 

1. Hold down the power switch on the rear panel (Figure 4) for a few seconds until the 

computer and the analyzer turn off.  

2. After another few seconds, restart the analyzer using the power button. 
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Appendix A - File Management 
The analyzer generates ASCII-format text output files. The data files are created every 60 

minutes by default. 

The file name is generated from the analyzer serial number, the date, and the time when the 

analyzer was started. For example: 

 

SADS2001-20160127-1029-DataLog_User_Raw.dat 

SADS2001 is the analyzer serial number 

20160127 is the date, 1/27/2016, in format yyyymmdd (to allow chronological sorting of data 

files). 

1029 is the time the file was started in GMT, 10:29 am, formatted as hhmm using a 24 hour 

clock. 

The raw user data is contained in folders in the directory:  

• /home/picarro/si2000/userdata/datalog_user/year/month/day/hour for data sampled at 

the analyzer’s native sampling rate 

• /home/picarro/si2000/userdata/datalog_sync/year/month/day/hour for data sampled at 

the analyzer’s native sampling rate 

Data files are created every 60 minutes and stored for 90 days (default for SADs analyzers) 

before they are automatically deleted. File deletion frequency and details can be modified in 

the file: /home/picarro/si2000/appconfig/config/archiver/archiver.ini. See Error! Reference s

ource not found.. 

During data acquisition, the analyzer creates directories to store the data, filed by the date the 

data were acquired. 

Figure 48 shows a partial example of a data file. 

 

Figure 48: Data File 

Datafiles are closed every 60 minutes and moved to an archive directory and a new datafile is 

started. 
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The archive directory is /home/picarro/si2000/log/archive and has subdirectories 

datalog_mailbox, datalog_private and datalog_eventlogs with files arranged by 

year/month/day/hour. 

There are more complete data files which include additional information beyond the 

concentration data including parameters such as analyzer temperatures and pressure, 

setpoints and spectroscopic information. This information is generally not useful to the user, 

but can be useful for diagnostic purposes and is store in the directory 

/home/picarro/si2000/log/archive/datalog_private /year/month/day/hour. 

For more information about how to include various columns of data from the datalog_private in 

the /home/picarro/si2000/userdata datalog files, contact Picarro. 

The currently active data file can be found in /home/picarro/si2000/log/datalogger. 

Archive directory contain subdirectories arranged by file type and internally organized by 

/year/month/day/hour.  

To keep the data files easy to manage and to limit the size of individual files and directories, 

new files are automatically generated whenever the analyzer is operating. 

The software automatically generates new files each time the analyzer is powered up and also 

at midnight (GMT) each night. When new files are created at midnight, their file name will 

contain the new date and a time of 00:00. 

For example, if the system was started at 10:29 am on 2/5/2016 it would create a file named 

20160205/sads2001-20160205-1029-userlog.dat. Then at midnight a new file will be created 

sads2001-20160206-0000-userlog.dat. 
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Appendix B - Status Log Messages 
Normal Start Up Messages 

Temperature Locked: WB 
The system waits for the warm box (WB – the temperature-controlled electronics and 

wavelength monitor chamber) to reach operating temperature.  

Temperature Locked: HB 
The system waits for the hot box (HB – the temperature-controlled chamber containing the 

analyzer’s optical cavity and gas handling system) is stabilized.  

This is typically the longest step in the startup sequence. The duration of this step can range 

from 5 to 60 minutes, depending on the ambient temperature and how much time has elapsed 

since the last startup. 

Preparing to Measure 
Spectral scanning has started. Concentration measurements will be available in approximately 

30 seconds. The analyzer continues to scan and report concentration measurements until the 

analyzer is shutdown using the procedure below. 

Figure 49 shows an example of the status log messages for startup. 

 

Figure 49: Sample Status Log Messages for Startup 

 

Pressure Stabilizing/Locked 
The valve control system begins to allow flow through the analyzer and stabilizes the pressure 

inside the cavity. 

Measuring 
This is the normal mode of operation after startup has completed. 
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Appendix C: Controlling External Valves 
This section explains how to control external valves using the built-in External Valve 

Sequencer GUI.  

If you are using the optional Picarro 16 Port Distribution Manifold with the analyzer, see the 

16 Port Distribution Manual User Guide for instructions on using the External Valve 

Sequencer GUI. 

Display the Show/Hide Valve Sequencer GUI 

1. Start the analyzer by double-clicking the Start Analyzer shortcut on the desktop. 

Wait for the analyzer to begin measuring. 

2. On the status bar menu of the analyzer Data Viewer screen, select Show/Hide Valve 

Sequencer GUI drop-down (Figure 50). 

 

Figure 50: Show/Hide Sequencer Drop-Down 

The External Valve Sequencer GUI displays (Figure 52). 
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The External Valve Sequencer Window 
This section describes the External Valve Sequencer window. 

Figure 51 shows the External Valve Sequencer window status bar menu items and actions. 

Figure 52 shows and describes the External Valve Sequencer window. 

File Menu 

Load a Valve Sequence File 
Click here to load saved files. Sequence Files are in: 

C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the Sequence File 

Save a Valve Sequence File 
Click Action/Save Valve Sequence File to save a valve sequence file. 

Action Menu 

Start Sequencer 
Click here to start a sequence. 

Go to First Step 
Click here to run step one (automatically resets to 1 from whatever step is currently being 

sampled). 

Reset All Valves 
Click here to change the current valve state to All Off. 

Hide Sequencer Interface 
This toggle shows or hides the Sequencer Interface window. To reveal the window click on the 

Show Sequencer Interface. 

 

Figure 51: External Valve Sequencer Window Drop-Down Menus 
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Current Status Fields 
The top row on the menu (see Figure 51 and 52) gives the current status of the current step. 

Current Step # 
Gives the number of the current step as defined by the setup 

Remaining Time (min) 
Time remaining on the current step 

Current Valve State 
Check boxes indicate which valves are energized 

Current Valve Code 
Binary code representing which valves are energized 

Current Rot. Valve Code 
Used only with gas distribution manifold 

Step Definition Fields 
Use the step definition fields to define the test sequence. 

Step # 
Enter the step number. 

Duration (min) 
Enter how long you want the step to last. 

Rot. Valve Code 
Used only with the gas distribution manifold 

Bottom Panel 
Use the bottom section of the window (Figure 52) to configure the sample. 

Total Steps 
Use this field to enter the total number of steps in the test. When the last step is finished, the 

sequencer loops back to the first step. 

Run Step # 
Shows the number of step currently running. If a different step is desired, enter that step 

number and click on Apply (Figure 52). 

Apply 
Click here to apply changes made using the External Valve Sequencer window. 

Run Next Step 
Forces the next step in the sequence. 

Start Date 
Use this field to enter the date to start the test. 



Controlling External Valves   

48  SI2104 H2S Analyzer User Guide 

Start Time 
Use this field to enter the time to start the test. 

Schedule Sequence 
Click this button to have the sequence start automatically at the date and time specified in the 

Start Date and Start Time fields. 

 

Figure 52: External Valve Sequencer Field Descriptions 
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Set Up a Test Sequence Using the Valve Sequencer Window 
A variety of sequences can be created and saved External Valve Sequencer window. This 

section explains how to set up a test sequence using the External Valve Sequencer window. 

To set up a sampling sequence: 

1. On the Picarro analyzer GUI, go to: 

• Tools 

• Show/hide valve sequencer 

 The External Valve Sequencer window displays. See Figure 52. 

2. Use the Rot. Valve Code column to set the rotary selector valve position.  

3. Enter the number (1-16) that corresponds to the desired valve position. 

A value of 1 in the Rot Valve Code field corresponds to position 2 on the valve. Only one 

rotary position can be selected per step. 

4. Enter the Step duration in the Duration (min) field, where the duration of the step is in 

minutes. If duration values are set to less than 0.1 minutes they may not be carried out 

correctly. 

5. Save the valve sequence as: 

/home/picarro/si2000/log/archive/datalog_private /year/month/day/hour 

Load and Run a Saved Sequence 
Load saved sequence files by clicking File/Load Valve Sequence. All the Sequence Files are 

in: 

/home/picarro/si2000/InstrConfig/ValveSequencer/Name of the Sequence File.  

1. Click Apply to run the sequence. 

To skip the next step click Run Next Step (even while in middle of running a step): 

2. Click on the Action scroll-down menu (Figure 51 and 52). 

3. Reset all Valves by changing all the Rot. Valve Code fields to Zero. 

4. Click on Go to the First Step (Whatever the step the user is at, step 1 will be played). 

5. Click on Start/Stop Sequencer (While the sequence is running, it will read Stop 

Sequencer). 

6. Click on Hide Sequencer Interface (this hides the External Valve Sequencer window).  
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Appendix D: Hazards 
The hazards identified and explained in this section might be encountered during maintenance 

or service tasks. 

Hazardous Voltage 

 
WARNING 

There are two location that the voltage potentials operate above 30 
Volts RMS.  The first location is in the rear of the instrument on power 
entry adapter in which the power cord plug plugs into. The second 
source is the power entry adapter in which the power cord plugs into 
the external pump. Refer to Manual Number 999085 included in the 
box for the Vacuubrand MD1 External Pump. 

 

Safety Provisions 

Enclosure, Overcurrent, Over Voltage, and Short Circuit Protection 
Enclosures protect the operators of the tool from contact with hazardous voltages during 

normal operation of the system.  If a short circuit, overcurrent condition, or over voltage 

occurs, the power supply will automatically shut down.  The power supply shall return to 

normal operation after the faulty event is rectified. 

Lockout/Tagout 
Prior to performing service on the Gas Analyzer, perform Lockout/Tagout on the power cord 

connected to the instrument by disconnecting it at the wall and at the instrument and placing it 

within your lockable toolbox. 
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Hazardous Material Content 

The European Union has identified certain substances that are considered environmentally 

hazardous according to the WEEE (Waste for Electrical and Electronic Equipment) and RoHS 

Directives. At the end of life of the instrument, the SI2000 Series Gas Analyzers shall be 

dismantled, and the hazardous materials shall be identified, sort, and collected. 

The WEEE directive sets minimum standards for recycling of electrical and electronic waste. 

Those standards must be met. Local practice may exceed the minimum standards. 

The crossed out wheeled bin symbol represents that hazardous content is included in the 

equipment. The equipment and parts with hazardous content shall not be disposed of with 

unsorted municipal waste. It is required that electrical and electronic equipment be disposed 

of under separate collection. 

 

Hazardous Material in Electronic Equipment 

• Lead is typically found in solder connections including PCBA terminations. 

• Mercury can be found in electronic components such as switches, and relays. 

• Lead, mercury and cadmium may be found in insulation of electrical cables. 

• Hexavalent Chromium may be used as a coating on frames, screw and fasteners. 

All parts with hazardous material shall be separated and disposed of to comply with 

applicable local laws and regulations including with European WEEE Directive. 
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Appendix E: Analog Signal Output 
Overview 
The SI analyzer is configured with an optional Electrical Interface Card (EIC) that provides 4 

analog signals for monitoring various measurement results and analyzer parameters. 

Two circular connectors, on the back panel of the analyzer are available for analog output. 

The pinout for each connector is listed in the table below.  

Figure 53 shows the analog channel connectors on the back of the analyzer. 

 

Figure 53: Analog Channel Connectors 

 

Two external cables (for the analog channel connectors) are provided with the analyzer. The 

mating connector is part number HR25-7TP-8P(72). Figure 3 describes the channel 

connectors. 

Table 3: Channel Connector Description 

Channel Parameter Output Scale (V) 
(<1 V indicates 

ERROR) 

Conversion Indicating Range 

0 H2S 0-10 10 ppb/V 0-90 ppb 

1 H2S 0-10 100 ppb/V 0-0.900 ppm 

2 H2S 0-10 2 ppm/V 0-18 ppm 

3 Logic Board 
Temp 

0-10 10 deg C/V 0-90 C 

4 N/A N/A N/A N/A 

5 N/A N/A N/A N/A 

6 N/A N/A N/A N/A 

7 N/A N/A N/A N/A 
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Analog Signal Pin Mapping 

Table 4 lists the analog pinouts and Figure 54 shows the analog pinout map. 

Table 4: Analog Pinout Table 

Pin Function  Pin Function 

1 GND 0  1 GND 4 

2 Channel 0  2 Channel 4 

3 GND 1  3 GND 5 

4 Channel 1  4 Channel 5 

5 GND 2  5 GND 6 

6 Channel 2  6 Channel 6 

7 GND 3  7 GND 7 

8 Channel 3  8 Channel 7 

 

 

 

Figure 54: Analog Pin Map 
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Contact Information 
Please contact Picarro or your authorized Picarro distributor for questions regarding specific 

applications and additional information.    

Contact Technical Support: 

Email:  support@picarro.com 

Phone:  408.962.3900 ext. 3991 

 

Contact Customer Service: 

Email:  orders@picarro.com 

Phone:  408.962.3900 ext. 3992 

 

Picarro, Inc. reserves the right to change or update the contents of this manual and to change 

the specifications of its products at any time without prior notification. Every effort has been 

made to keep the information in this document current and accurate as of the date of 

publication or revision. However, no guarantee is given or implied that this document is error 

free or that it is accurate with regard to any specification. 

Picarro, Inc. has prepared this manual for use by its customers as a guide for the proper 

installation, operation and/or maintenance of the Picarro analyzer. 

Picarro and the Picarro logo are trademarks of Picarro, Inc. 

 

 2017 Picarro, Inc. All rights reserved. 

3105 Patrick Henry Drive 

Santa Clara, California, 95054 

USA 
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